
 

Release Notes 

D9040MPHC 

MIPI M-PHY Conformance 

Test Application 

Keysight D9040MPHC Software Version 02.30.0002 

Released Date: 27 AUG 2019 

Requirements category (e.g., operating system): Microsoft Windows 7, Microsoft Windows 10 

Requirements category (e.g., instrument software version): 06.40.01001 (9000 Series, 90000 Series, 90000 X-Series, 

90000 Q-Series, Z-Series), 

10.11.04711 (UXR-Series) 

File Name: SetupInfMIPI_M-PHY02309002.exe 

Miscellaneous Notes 

- NA 

New Features 

- Added support for new export to repository feature where user can export test results to a 

repository (such as a database). [File->Export Results…->Repository] 

Bug Fixes 

- Fixed typo on “SA_NT – Large Amplitude Unterminated Mode” in Setup tab. 

- Fixed “Unable to find Marker0” issue on Test 1.1.9 T_L2L_Skew test. 

- Fixed remote access issue on N7010A Calibration feature. 

- Fixed issue where there is no message prompted when user selected “Tools-> Infiniium -> 

InfiniiSim…” or “Tools-> Infiniium -> PrecisionProbe/PrecisionCable…” feature without 

installing the required license. 
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- Fixed issue where Test 1.1.6 and Test 1.2.9 did not show execution status after test had 

completed. 

Known issues 

- Screenshot timeout issue can happen rarely when running tests. 

- Screen might go white during N7010A Calibration. 

- Infiniium might goes in irresponsive when channel hardware differential is turned on with 

channel skew in UXR-Series oscilloscope. 
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Keysight D9040MPHC Software Version 02.30.0001 

Released Date: 4 JUNE 2019 

Requirements category (e.g., operating system): Microsoft Windows 7, Microsoft Windows 10 

Requirements category (e.g., instrument software version): 06.40.00714 (9000 Series, 90000 Series, 90000 X-Series, 

90000 Q-Series, Z-Series), 

10.10.04513 (UXR-Series) 

File Name: SetupInfMIPI_M-PHY02300001.exe 

Miscellaneous Notes 

- Updated the product number from “U7249E” to “D9040MPHC” to support PPKS licenses. 

Enhancements 

- Migrated application to use new graphics user interface environment. 

- Updated test limit on Test 1.1.9 T_L2L_Skew for “UniPro” and “HS-G4”. 

- Added configurable option of “SigTest Template Files” (with remote name of 

“SigTestTemplateFiles”) in Configure tab. This configurable option is used to specify the 

SigTest Template files to be used when performing SigTest. 

- Updated 1.1.7 TEYE_G4 _RT_TX, VDIF_AC_G4 _RT_TX [SigTest] (C) to support new set of 

template files for different test cases. 

- Added configurable option of “PLL Settling Time (for 2nd Order PLL)” (with remote name of 

“SettlingTime”) in Configure tab. 

- Updated connection diagram.  

Bug Fixes 

- Fixed issue on triggering on high data rate signal. 

Known issues 

- Does NOT support backward compatibility. Project files saved in previous versions will be 

available as READ-ONLY. User have to save previous project files as Settings Only before 

loading the project in the current software to access all the supported configurations. 

[File->Save Project (Settings Only) As...] 

- User will experience the increase in the test time when running Test 1.1.6 TEYE, VDIF_AC, 

Tests 1.1.7 TEYE_G3, VDIF_AC_G3 and Test 1.1.7 TEYE_G4, VDIF_AC_G4 tests with 

N7010A Active Termination Adapter in UXR-Series oscilloscope.  
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- Screenshot timeout issue can happen rarely when running tests. 

- No message will be prompted when user selected “Tools-> Infiniium -> InfiniiSim…” or 

“Tools-> Infiniium -> PrecisionProbe/PrecisionCable…” feature without installing the 

required license.  

- Export to repository feature where user can export test results to a repository (such as a 

database) [File->Export Results…->Repository] is not supported. 

- Remote access feature for N7010A is not supported. 
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Keysight U7249E Software Version 02.22 

Released Date: 11 JAN 2019 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 06.30.00701 (9000 Series) 

06.30.00701 (90000 Series, 90000 X-Series, 90000 Q-

Series, Z-Series), 

10.00.03902 (UXR-Series) 

File Name: SetupInfMIPI_M-PHY02220000.exe 

Bug Fixes 

- Fixed timeout issue on Test 1.1.8 TR_TF when running on UXR-Series oscilloscope. 

Known issues 

- In loading projects created in MIPI MPHY version 02.21, users cannot append the existing 

results. 

- User will experience the increase in the test time when running Test 1.1.6 TEYE, VDIF_AC, 

Tests 1.1.7 TEYE_G3, VDIF_AC_G3 and Test 1.1.7 TEYE_G4, VDIF_AC_G4 tests with 

N7010A Active Termination Adapter in UXR-Series oscilloscope.  

- Screenshot timeout issue can happen rarely when running tests. 
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Keysight U7249E Software Version 02.21 

Released Date: 27 SEPT 2018 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 06.30.00517 (9000 Series) 

06.30.00517 (90000 Series, 90000 X-Series, 90000 Q-

Series, Z-Series), 

10.00.03708 (UXR-Series) 

File Name: SetupInfMIPI_M-PHY02210000.exe 

New Features 

- Supports Infiniium Oscilloscope Software version 10.00 for UXR-Series oscilloscope. 

o Added new options (4GSa/s, 8GSa/s, 16GSa/s, 32GSa/s, 64GSa/s, 128GSa/s) for 

“Sampling Rate, GSa/s” (with remote name of “SRate”) configurable option in 

Configure tab. These options will be available when launching application on UXR-

Series Oscilloscope. The default value is “Default”. 

- Added N7010A Active Termination Adapter Calibration feature in Connection Setup form. 

The continuous HS signal is required for N7010A calibration. The calibration will be 

performed on Primary Test Lane only.  

o Added “RSE Method” selection (with remote name of “RSEValueMethod”) in 

N7010A Calibration Setup form with the options of “Manual RSE” and “Calculated 

RSE”. This option allows user to specify the RSE value manually or auto calculated 

by application for N7010A Calibration. 

o Added “RSE Value” configurable option (with remote name of 

“RSE_ActiveTerminationCal”) in N7010A Calibration Setup form which is only 

available if user selected “Manual RSE” for “RSE Method” selection. This option 

allows user to specify the RSE value manually. 

o Added InfiniiSim selections for TXDP (with remote name of “TXDPInfiniiSimCal”) 

and TXDN (with remote name of “TXDNInfiniiSimCal”) signals in N7010A 

Calibration Setup form. These options allow user to enable InfiniiSim feature for 

TXDP and TXDN signals prior to N7010A Calibration. Added “Transfer Function 

File” configurable option for TXDP (with remote name of 

“TXDPTransferFunctionFileCal”) and TXDN (with remote name of 

“TXDNTransferFunctionFileCal”) signals. These options allow user to specify the 

transfer function file for embedding/de-embedding.  

o Added “N7010A Calibration” configurable option which enable user to find the 

appropriate Vterm value. The calculated “Vterm” value and “RSE” value will be 

displayed and the Vterm value will be applied for all tests after performing the 
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N7010A Calibration if user selected “Active Probe (Active Termination Adapter)” for 

both “Probing Method” configurable option. For remote user, this N7010A 

Calibration can be executed remotely by setting “PerformN7010ACalibration” 

configuration option to “1.0”.  

o Added configurable option of “Interpolation Factor(L2L_SKEW)” in Configure tab 

which allows user to specify the interpolation factor to be used when loading 

waveforms for Test 1.1.9 T_L2L_SKEW tests. 

- Added the following new tests to support Test 1.1.7 TEYE_G4, VDIF_AC_G4 testing for HS-

Continuous mode using CTLE and DFE feature from Infiniium. These tests will be enabled if 

user selected “v4.0 and v4.1” for configurable option of “CTS”, selected “HS-G4” data rate, 

checked “Informative Test” and unchecked “SigTest” Test Method in Set Up tab. 

o Test ID: 1845 - 1.1.7 TEYE_G4_LA_RT_TX, VDIF_AC_G4_LA_RT_TX [CH1] [0dB] (C) 

o Test ID: 1846 - 1.1.7 TEYE_G4_LA_RT_TX, VDIF_AC_G4_LA_RT_TX [CH2] [6dB] (C) 

o Test ID: 1745 - 1.1.7 TEYE_G4_SA_RT_TX, VDIF_AC_G4_SA_RT_TX [CH1] [3.5dB] 

(C) 

- Added “CTLE Setting File” configurable option (with remote name of “CTLESettingFile”) in 

Configure tab which enables user to specify the CTLE Setting file to be used when 

performing Test 1.1.7 TEYE_G4, VDIF_AC_G4 (C). 

- Added “CTLE Optimization Criterion” configurable option (with remote name of 

“CTLEOptimizationCriterion”) in Configure tab which enables user to specify the criterion 

used to determine the optimal CTLE setting among all CTLE setting stated in CTLE Setting 

File. 

- Added “DFE Voltage(V)” configurable option (with remote name of “DFEVoltage”) in 

Configure tab which enables user to specify the DFE Voltage to be applied for DFE 

equalization. 

- Added “DFE Eye Diagram Position” configurable option (with remote name of 

“DFEEyeDiagramPosition”) in Configure tab which enables user to specify the eye diagram 

position after applying DFE equalization. 

- Added “CTLE Outer Voltage Check Range(V)” configurable option (with remote name of 

“CTLEOuterVoltageCheckRange”) in Configure tab which enables user to specify the 

voltage range to be applied for CTLE Outer voltage checking where the outer voltage of 

eye diagram must within VDIF_AC maximum - (CTLE Outer Voltage Check Range). 
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Enhancements 

- Added “Interpolation Factor(L2L_SKEW)” configurable option (with remote name of 

“Interpolation_L2LSkew”) in Configure tab which allows user to specify the interpolation 

factor to be used when loading waveforms for Test 1.1.9 T_L2L_SKEW tests. By default, it 

is set to “OFF”. 

- Updated the data rate and UI measurement where the nominal data rate will be 

determined by the “Nominal HS Data Rate” in the Setup tab when user selected “Semi-

Automatic” for “Data Rate Mode” in Configure tab. Removed 'Nominal Data rate' 

configurable option (with remote name of “NominalDataRate_fOffset”) from the Configure 

tab. 

- Added “Transfer Function File (G3)[HS-Continuous Only]” configurable option (with remote 

name of “G3ContinuousBEREyeTFFile”) in Configure tab which enables user to disable 

reference channel embedding for Test 1.1.7 TEYE_G3, VDIF_AC_G3 (C) tests. 

- Added “OFF” option for “Transfer Function File (G4)” configurable option (with remote 

name of “G4BEREyeTFFile”) in Configure tab which enables user to disable the reference 

channel embedding for Test 1.1.7 TEYE_G4, VDIF_AC_G4 (C) tests. 

- Turn off package model embedding in SigTest Tool’s template file.  

Bug Fixes 

- Fixed intermittent unable to measure Unit Interval issue in Test 1.1.1 f_Offset. 

- Fixed unable to find SYNC pattern in Test 1.1.9 T_L2L_Skew test. 

- Updated PLL Settling Time value from 10mT to 1T for TEYE tests. 

- Updated the pass test criteria for Test 1.2.3 TPWM_PREPARE for “CTS v4.0 and v4.1” 

option. 

- Fixed mask value for Test 1.1.7 TEYE_G3, VDIF_AC_G3. 

- Fixed the unit and precision level for “Number of Mask Violation” reporting item for Test 

1.1.6 TEYE, VDIF_AC, Test 1.1.7 TEYE_G3, VDIF_AC_G3 and Test 1.1.7 TEYE_G4, 

VDIF_AC_G4 tests. 

- Fixed finding edge algorithm in Test 1.1.5 VDIF_CD to find the correct position of DIF-P 

region. 

- Fixed issue on the applied template file for Test HS-G4 signal on Test 1.1.7 TEYE_G4, 

VDIF_AC_G4[SigTest]. 
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- Fixed description in Connection diagram for burst mode tests. 

Known issues 

- In loading projects created in MIPI MPHY version 02.20, users cannot append the existing 

results. 

- User will experience the increase in the test time when running Test 1.1.6 TEYE, VDIF_AC, 

Tests 1.1.7 TEYE_G3, VDIF_AC_G3 and Test 1.1.7 TEYE_G4, VDIF_AC_G4 tests with 

N7010A Active Termination Adapter in UXR-Series oscilloscope.  

- Screenshot timeout issue can happen rarely when running tests. 
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Keysight U7249E Software Version 02.20 

Released Date: 22 AUG 2017 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 06.00.01001 (90000 Series, 90000 X-Series, 90000 Q-

Series, Z-Series), 

06.00.01001 (9000 Series) 

File Name: SetupInfMIPI_M-PHY02200000.exe 

Miscellaneous Notes 

- Updated product model from “U7249C/U7238D” to “U7249E”. 

- Updated the license requirements where the MIPI M-PHY 4.1 Upgrade [M4U] or MIPI M-

PHY 4.1 Compliance [MP4] is required to enable CTS “v4.0 and v4.1” option. 

 

New Features 

- Added “CTS” configurable option (with remote name of “CTSVersion”) in Set Up tab with 

the options of “v3.0” and “v4.0 and v4.1”. This option allows user to specify the CTS version 

to reflect the available test list accordingly.  

- Added support for the following HS-G4 Data Rate to support CTS “v4.0 and v4.1”.  

o HS-G4A (9984)  

o HS-G4B (11648.0) 

o HS-G4B (11660.8) 
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o HS-G4B (11673.6) 

- Added “MIPI M-PHY Test Limit v4.0 and v4.1” compliance limit set to support CTS “v4.0 

and v4.1”. This compliance limit set will be activated if user selected “v4.0 and v4.1” for 

configurable option of “CTS”. The test limit for the following tests will be different from CTS 

“v3.0”: 

o Test 1.1.4 VCM 

o Test 1.1.5 VDIF_DC 

o Test 1.2.4 VCM 

o Test 1.2.5 VDIF_DC 

o Test 1.2.7 VDIF_AC 

- Updated the mask value for the following tests to support CTS “v4.0 and v4.1”. 

o Test 1.1.6 TEYE, VDIF_AC (B) 

o Test 1.1.7 TEYE_G3, VDIF_AC_G3 (B) 

o Test 1.1.6 TEYE, VDIF_AC (C) 

o Test 1.1.7 TEYE_G3, VDIF_AC_G3 (C) 

- Updated the following tests as informative tests to support CTS “v4.0 and v4.1”.  

Test Name CTS v3.0 CTS v4.0 and v4.1 

Test 1.1.8 TR, TF (B) Compliance test Informative test 

Test 1.1.14 TPULSE (B) Compliance test Informative test 

Test 1.1.6 TEYE, VDIF (B) Compliance test Informative test 

Test 1.1.7 TEYE_G3, 

VDIF_AC_G3 (B) 

Compliance test Informative test 

- Added configurable option of “SigTest” (with remote name of “TEYESigTestEnable”) in Set 

Up tab. This configurable option is used to enable or disable Test 1.1.7 TEYE_G4, 

VDIF_AC_G4 [SigTest] tests. 

- Added the following new tests to support Test 1.1.7 TEYE_G4, VDIF_AC_G4 testing for HS-

Continuous mode using SigTest Tool. These tests will be enabled if user selected “v4.0 and 

v4.1” for configurable option of “CTS”, selected “SigTest” Test Method and “HS-G4” data 

rate in Set Up tab. 

o Test ID: 1843 - 1.1.7 TEYE_G4_LA_RT_TX, VDIF_AC_G4_LA_RT_TX [CH1] [0dB] 

[SigTest] (C) 
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o Test ID: 1844 - 1.1.7 TEYE_G4_LA_RT_TX, VDIF_AC_G4_LA_RT_TX [CH2] [6dB] 

[SigTest] (C) 

o Test ID: 1743 - 1.1.7 TEYE_G4_SA_RT_TX, VDIF_AC_G4_SA_RT_TX [CH1] [3.5dB] 

[SigTest] (C) 

- Added configurable option of “Specification Version” (with remote name of 

“SpecificationVersion”) in Configure tab with options of “v4.0” and “v4.1”. This configurable 

option is used to specify the specification version that determine the targeted BER to be 

used for Test 1.1.6 TEYE, VDIF_AC, Test 1.1.7 TEYE_G3, VDIF_AC_G3, Test 1.1.15 TJ, Test 

1.1.16 STTJ, Test 1.1.17 DJ and Test 1.1.18 STDJ. This configurable option is only 

applicable for CTS “v4.0 and v4.1” selection.  

- Added new test ID and renamed existing tests to support Test 1.1.7 TEYE_G3, VDIF_AC_G3 

for HS-Continuous mode to test for three test cases.  

Added the following new test: 

o Test ID: 1823 - 1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX [CH2] [6dB] (C) 

Renamed the following tests: 

o Test ID: 1822 - 1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX [CH1] [0dB] (C) 

[Old Name: 1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX (C)] 

o Test ID: 1722 - 1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA_RT_TX [CH1] [3.5dB] 

(C) 

[Old Name: 1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA_RT_TX (C)] 

- Added configurable option of “Transfer Function File(G4)” (with remote name of 

“G4BEREyeTFFile”) in Configure tab. This configurable option is used to set the transfer 

function file that will be embedded when performing Test 1.1.7 TEYE_G4, VDIF_AC_G4 

[SigTest] (C). 

Enhancements 

- Removed “Total Jitter BER Target” (with remote name of “RJDJBER”) configuration option 

from Configure tab. 

- Renamed “Reference Channel Transfer Function File (G3)” (with remote name of 

“BEREyeRefChanTFFile”) configuration option from Configure tab to “Reference Channel 

Transfer Function File (G3)[HS-Burst Only]”.  
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- Moved “Protocol Specification” (with remote name of “ProtocolSpecificationL2L”) 

configuration option from Configure tab to Set Up tab. Added “M-PCIe” protocol 

specification for CTS “v4.0 and v4.1” selection. The test availability and test limit of Test 

1.1.9 HS-TX Lane-to-Lane Skew and Test 1.2.9 PWM-TX Lane-to-Lane Skew tests will be 

changed based on the “Protocol Specification” selection. 

- Reported mask violation value for all three regions in Test 1.2.6 TEYE test. 

Bug Fixes 

- Fixed timeout issue in Test 1.1.9. 

- Renamed “Data Rate Mode[f_Offset]” (with remote name of “DataRateMode_fOffset”) and 

“Nominal Data Rate[f_Offset]” (with remote name of “NominalDataRate_fOffset”) 

configuration option to “Data Rate Mode” and “Nominal Data Rate”. Corrected description 

for these configuration options. 

Known issues 

- In loading projects created in MIPI MPHY version 02.13, users cannot append the existing 

results. 
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Keysight U7249C\U7249D Software Version 02.13 

Released Date: 24 March 2017 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 06.00.00602 (90000 Series, 90000 X-Series, 90000 Q-

Series, Z-Series), 

06.00.00602 (9000 Series) 

File Name: SetupInfMIPI_M-PHY02130000.exe 

Enhancements 

- Updated Test 1.1.2 PSDCM test to use wrapper and matlab for plotting Power Spectral 

Density graph. 

Bug Fixes 

- Removed horizontal scale setting on differential function. 

- Updated to display a proper message when test is cancelled by user.  

- Fixed sequence issue on Test 1.1.6 TEYE. 

Known issues 

- In loading projects created in MIPI MPHY version 02.11, users cannot append the existing 

results. 

 

 

 

 

 

 

 

 

 



D9040MPHC MIPI M-PHY Conformance Test Application Release Notes 

15 

 

Keysight U7249C\U7249D Software Version 02.11 

Released Date: 2 DECEMBER 2016 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 5.70.00715 (90000 Series, 90000 X-Series, 90000 Q-

Series, Z-Series), 

5.70.00715 (9000 Series) 

File Name: SetupInfMIPI_M-PHY02110000.exe 

New Features 

- Enabled “Disable Infiniium user interface during run” feature.  

Enhancements 

- Added enhancement to check and display error message if the number of copies of pattern 

found is insufficient for processing for Test 1.1.8 TR_TF_HS_TX. 

Bug Fixes 

- N/A 

Known issues 

– In loading projects created in MIPI MPHY version 02.10, users cannot append the existing 

results. 
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Keysight U7249C\U7249D Software Version 02.10 

Released Date: 5 APRIL 2016 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 5.60 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 

5.60 (9000 Series) 

File Name: SetupInfMIPI_M-PHY02100000.exe 

Miscellaneous Notes 

– Rebranding U7249C\U7249D MIPI M-PHY Conformance Test Application under Keysight 

Technologies. 

New Features 

– Support for Active Termination Adapter (N7010A). The minimum supported Infiniium 

version for this feature is Infiniium v5.50.0006.  

– Added new option of “Active Probe (Active Termination Adapter)” and “Active Probe (Active 

Termination Adapter)[Manual]” for both “Probing Method-No switch” (with remote name of 

“Probing Method”) and “Probing Method-with switch” (with remote name of 

“SwitchMatrixProbeMethod”) configuration options in Connection Setup form to support 

Active Termination Adapter (N7010A). 

These options are applicable for Active Termination Adapter (N7010A) usage only. The 

measurement algorithm of Test 1.1.4 VCM (B) and Test 1.2.4 VCM tests is dependent on 

probing method setting. 

For “Active Probe (Active Termination Adapter)” probing method, the Vterm value is set to 

0V for all tests except Test 1.1.4VCM(B) and Test 1.2.4 VCM tests. For Test 1.1.4 VCM(B) 

and Test 1.2.4 VCM tests, the Vterm value will be computed during these tests and only 

apply for these tests. 

For “Active Probe (Active Termination Adapter)[Manual]” probing method, user will need to 

configure the Vterm value using Infiniium’s Probe Configuration dialog box before running 

tests. The configured Vterm value is apply for all tests.  

– Added new test IDs for 1.1.4 VCM (B) and 1.2.4 VCM tests to support ““Active Probe 

(Active Termination Adapter)” probing method.  

HS-Burst Mode: 

o Test ID: 834, 734 
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LS-PWM Mode: 

o Test ID: 434, 334, 234, 134 

– Added new test IDs for 1.1.4 VCM (B) and 1.2.4 VCM tests to support “Active Probe (Active 

Termination Adapter[Manual]” probing method.  

HS-Burst Mode: 

o Test ID: 835, 735 

LS-PWM Mode: 

o Test ID: 435, 335, 235, 135 

- Added “Interpolation Factor” (with remote name of “PWM_TEYEInterpolationFactor”) 

configuration option. This option is used to specify the interpolation factor to be used when 

loading waveform file for eye diagram generation. This option is only application for Test 

1.2.6 TEYE and Test 1.2.7 VDIF_AC tests. 

- Added “Data Rate Mode[f_Offset]” (with remote name of “DataRateMode_fOffset”) 

configuration option. This option is used to specify the data rate mode used for Unit 

Interval measurement in Test 1.1.1 f_Offset. 

- Added “Nominal Data Rate[f_Offset]” (with remote name of “NominalDataRate_fOffset”) 

configuration option. This option is used to specify the nominal data rate used for Unit 

Interval measurement in Test 1.1.1 f_Offset. This config is only applicable if the user 

selected "Semi-Automatic" for "Data Rate Mode[f_Offset]" configuration option. 

Modifications 

– Updated the choice of “Probing Method-No switch” (with remote name of “Probing 

Method”) configurable option in Connection Setup form. The choice of “Active Probe” was 

updated to “Active Probe (Differential Probe)”.  

– Move “Switch Matrix Data Lane Probing Method” (with remote name of 

“SwitchMatrixProbeMethod”) configurable option from Configure tab to Connection Setup 

form in Set Up tab. This option is named as “Probing Method-with switch”. Updated the 

choices to “Active Probe (Differential Probe)” and “Direct Connect” from “DiffProbe” and 

“SMA”.  

– Updated Test 1.1.7 TEYE-G3-TX, VDIF-G3-TX tests as informative tests for HS-G3A data 

rate selection. 

o Test ID: 802 - 1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX (B) 
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o Test ID: 702 - 1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA_RT_TX (B) 

o Test ID: 1822 - 1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX (C) 

o Test ID: 1722- 1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA_RT_TX (C) 

– Updated Test 1.2.6 TEYE-TX tests as informative tests. 

o Test ID: 401- 1.2.6 TEYE_LA_RT_TX 

o Test ID: 301 - 1.2.6 TEYE_SA_RT_TX 

o Test ID: 201 - 1.2.6 TEYE_LA_NT_TX 

o Test ID: 101 - 1.2.6 TEYE_SA_NT_TX 

– Updated Test 1.2.8 TR_TF-PWM-TX tests to run Test 1.2.1TPWM-TX test as pre-requisite 

test. The TPWM-TX value measured from Test 1.2.1 will be used to calculate the dynamic 

limit for Test 1.2.8.  

– Updated the label of “HS Data Rate [Mbps]” to “Nominal HS Data Rate [Mbps]” in Setup 

tab. 

– Updated the vertical offset value of the differential waveform to 0V for Test 1.1.6 TEYE(C) 

and Test 1.1.7 TEYE_G3(C) tests. 

Bug Fixes 

– Fixed issue on 1.2.1 TPWM-TX(MIN) test where the algorithm is unable to find correct 

falling edges to calculate the TPWM.   

– Fixed issue on 1.1.2 PSDCM test.  

– Fixed issue on SerialPatternFinderMPHY User-Defined function. Use 0V as middle 

threshold to identify edges. 

– Fixed histogram data streaming issue on 1.1.6 TEYE test.  

– Fixed issue on ButterMPHYfilter User-Defined function. The number of UI transition for test 

signal will be checked before applying ButterMPHYfilter User-Defined function.  

– Fixed issue on Test 1.2.7 VDIF_AC where there is no histogram hits within histogram 

window. Updated the application to load waveform file with interpolation (INT16) to resolve 

the issue. 
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– Fixed triggering issue where application unable to trigger signal with data rate >4Gbps 

that doesn’t have positive pulse width >250ps. Changed triggering method to edge trigger 

for HS-Continuous signal type. 

– Fixed issue on Test 1.2.6 TEYE test where the measurement result is not converted to UI 

unit correctly if “AUTO” PWM Gear is selected.  

Known issues 

– In loading projects created in MIPI MPHY version 02.02, users cannot append the existing 

results. 
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Agilent U7249C\U7249D Software Version 02.02 

Released Date: 5 MARCH 2015 

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7 

Requirements category (e.g., instrument software version): 4.20 (9000 Series, 90000 Series, 90000 X-Series) 

File Name: SetupInfMIPI_M-PHY02020000.exe 

Miscellaneous Notes 

– This will be the last version to support Infiniium Oscilloscope Baseline Version 4.20. 

New Features 

– Added new test IDs to support eye mask test at far-end TX probing point. These tests are 

added as informative tests. The RX eye mask is applied in these tests.  

HS-Burst Mode: 

o LA_RT Test Group 

▪ Test ID: 841 - 1.1.6 TEYE_LA_RT_TX, VDIF_AC_LA_RT_TX [Far End HS-RX 

Test Point] (B) 

▪ Test ID: 842 - 1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX [Far End 

HS-RX Test Point] (B) 

o SA_RT Test Group 

▪ Test ID: 741 - 1.1.6 TEYE_SA_RT_TX, VDIF_AC_SA_RT_TX [Far End HS-RX 

Test Point] (B) 

▪ Test ID: 742 - 1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA_RT_TX [Far End 

HS-RX Test Point] (B) 

HS-Continuous Mode: 

o LA_RT Test Group 

▪ Test ID: 1841 - 1.1.6 TEYE_LA_RT_TX, VDIF_AC_LA_RT_TX [Far End HS-RX 

Test Point] (C) 

▪ Test ID: 1842 - 1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX [Far End 

HS-RX Test Point] (C) 
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o SA_RT Test Group 

▪ Test ID: 1741 - 1.1.6 TEYE_SA_RT_TX, VDIF_AC_SA_RT_TX [Far End HS-RX 

Test Point] (C) 

▪ Test ID: 1742 - 1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA_RT_TX [Far End 

HS-RX Test Point] (C) 

– Added the configuration option “Total Acquisition Length [UI]” (with remote name of 

“TotalBEREyeAcqLen”) in Configure tab.  

Modifications 

– Updated the “DUTDataRate” configuration option where it will not accept any “user-

defined text” through remote.  

– Updated the choices of “Scope Bandwidth” configuration option. 

– Updated the test algorithm for the following tests to comply with MIPI MPHY CTS v3.0r17. 

HS-Burst Mode: 

o LA_RT Test Group 

▪ Test ID: 801 - 1.1.6 TEYE_LA_RT_TX, VDIF_AC_LA_RT_TX (B) 

▪ Test ID: 802 - 1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX (B) 

o SA_RT Test Group: 

▪ Test ID: 701 - 1.1.6 TEYE_SA_RT_TX, VDIF_AC_SA_RT_TX (B) 

▪ Test ID: 702 - 1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA_RT_TX (B) 

HS-Continuous Mode: 

o LA_RT Test Group 

▪ Test ID: 1821 - 1.1.6 TEYE_LA_RT_TX, VDIF_AC_LA_RT_TX (C) 

▪ Test ID: 1822 - 1.1.7 TEYE_G3_LA_RT_TX, VDIF_AC_G3_LA_RT_TX (C) 

o SA_RT Test Group: 

▪ Test ID: 1721 - 1.1.6 TEYE_SA_RT_TX, VDIF_AC_SA_RT_TX (C) 

▪ Test ID: 1722- 1.1.7 TEYE_G3_SA_RT_TX, VDIF_AC_G3_SA_RT_TX (C) 
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– Removed the following tests IDs from the application.  

HS-Burst Mode: 

o Test ID: 1801 - 1.1.6 TEYE_LA_RT_TX (B) 

o Test ID: 1802 - 1.1.7 VDIF_AC_LA_RT_TX (B) 

HS-Continuous Mode: 

o Test ID: 1701 - 1.1.6 TEYE_LA_RT_TX (C) 

o Test ID: 1702 -  1.1.7 VDIF_AC_LA_RT_TX (C) 

– Updated Test 1.1.2 PSDCM-TX, Test 1.1.15 TJ-TX, Test 1.1.16 STTJ-TX, Test 1.1.17 DJ-TX 

and Test 1.1.18 STDJ-TX tests as Informative tests.  

HS-Burst Mode: 

o LA_RT Test Group: 

▪ Test ID: 816 - 1.1.2 PSDCM_LA_RT_TX (B) 

o SA_RT Test Group: 

▪ Test ID: 716 - 1.1.2 PSDCM_SA_RT_TX (B) 

HS-Continuous Mode: 

o LA_RT Test Group: 

▪ Test ID: 1812 - 1.1.15 TJ_LA_RT_TX (C) 

▪ Test ID: 1814 - 1.1.16 STTJ_LA_RT_TX (C) 

▪ Test ID: 1813 - 1.1.17 DJ_LA_RT_TX (C) 

▪ Test ID: 1815 - 1.1.18 STDJ_LA_RT_TX (C) 

o SA_RT Test Group: 

▪ Test ID: 1712 - 1.1.15 TJ_SA_RT_TX (C) 

▪ Test ID: 1714 - 1.1.16 STTJ_SA_RT_TX (C) 

▪ Test ID: 1713 - 1.1.17 DJ_SA_RT_TX (C) 

▪ Test ID: 1715 - 1.1.18 STDJ_SA_RT_TX (C) 
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– Removed the following configuration options from the application. 

Label Configuration option 

RJ Method  BEREyeRJMethod 

RJ Bandwidth RJBandwidth 

Total Jitter BER Target NoiseBER 

Pattern Repetition  NoisePatternLength 

Non-Periodic Pattern Filter Lead NoiseFilterLead 

Non-Periodic Pattern Filter Lag NoiseFilterLag 

Single Acquisition Length [UI] BEREyeAcqLen 

 

Bug Fixes 

– Fixed remote programming issue.  

– Fixed InfiniiSim related bug in the application 

– Corrected the typo label of “Secondly” to “Secondary” on Connection Setup Form. 

Known issues 

– In loading projects created in MIPI MPHY version 02.01, users cannot append the existing 

results. 
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Agilent U7249C\U7249D Software Version 02.01 

Released Date: 26 SEPTEMBER 2014 

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7 

Requirements category (e.g., instrument software version): 4.20 (9000 Series, 90000 Series, 90000 X-Series) 

File Name: SetupInfMIPI_M-PHY02010000.exe 

New Features 

– Added “Active Probe” and “Direct Connect” probing method options.  

– Added 1.2.3 TPWM-PREPARE Length test under LS-PWM Mode. 

– Added “Optical Media Converter(OMC)”, “TX_LS_PREPARE_LENGTH”, “MC_LS_PREPARE 

LENGTH” and “TLINE_RESET_DETECT” configuration options. These options are used for 

1.2.3 TPWN-PREPARE Length test.  

– Added “VDIF_AC Histogram Window” configuration option. This option is used to specify 

the location of histogram window for 1.2.7 VDIF_AC test under LS-PWM Mode. 

– Support for multiple test groups(LA_RT, SA_RT, LA_NT, SA_NT) selection in single trial. 

– Added “Number of 0011 and 1100 patterns” configuration option. This option is used to 

select the number of rise/fall time measurement. 

– Added “Interpolation” configuration option. This option is used to enable/disable the 

interpolation feature for 1.1.8 TRTF test and 1.1.10 SR_DIF test.  

– Added 1.2.9 T_L2L_Skew test under LS-PWM Mode.  

Modifications 

– Update eye mask for HS-G3 in 1.1.6 TEYE test.  

– Update 1.1.3 HS-PREPARE Length test algorithm. 

– Update 1.1.8 TRTF test algorithm to perform rise time and fall time measurement on 0011 

and 1100 patterns, respectively.  

– Update 1.1.10 SR_DIF test algorithm to perform rise time measurement on 0011 pattern 

only. 

– Unify connection setting for all tests.  

– Move “Connection Setup” to Set Up tab.  

– Update 1.2.7 VDIF_AC test algorithm to perform VDIF_AC measurement on all PWM bits.  
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– Update test limit of 1.1.3 HS-PREPARE Length test. 

Bug Fixes 

– Fixed issue where the application crash when user selected more than one data lane.  

– Fixed mask test issue for 1.1.6 TEYE test.  

Known issues 

– In loading projects created in MIPI MPHY version 02.00, users cannot append the existing 

results. 
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Agilent U7249C\U7249D Software Version 02.00 

Released Date: 30 MAY 2014 

Requirements category (e.g., operating system): Microsoft Windows XP, Microsoft Windows 7 

Requirements category (e.g., instrument software version): 4.20 (9000 Series, 90000 Series, 90000 X-Series) 

File Name: SetupInfMIPI_M-PHY02000000.exe 

New Features 

– Added 1.1.3 HS-PREPARE Length test under HS- Burst Mode. 

– Added “TX_HS_PREPARE_LENGTH” configuration option under HS Burst Data mode. This 

option is used to define the test limit for the test. 

– Added 1.1.6 TEYE (BER 1E-10) and 1.1.6 TEYE_G3 (BER 1E-10) tests under HS- 

Continuous Mode.  

– Added 1.1.9 Lane-to-Lane Skew test under HS- Burst Mode. 

– Added “Protocol Specification” and “Test Limit for DigRFv4 Protocol Specification” 

configuration options for Lane-to-lane Skew test under HS Burst Data mode. These 

options are used to define the test limit for the test.  

– Added 1.1.1 Unit Interval and Frequency Offset [MAX] and 1.1.1 Unit Interval and 

Frequency Offset [MIN] tests. 

– Added 1.2.1 PWM-TX Transmit Bit Duration (TPWM) [MAX] and 1.2.1 PWM-TX Transmit 

Bit Duration (TPWM) [MIN] tests. 

– Added 1.2.2 PWM-TX Transmit Ratio (kPWM) [MAX] and 1.2.2 PWM-TX Transmit Ratio 

(kPWM) [MIN] tests. 

– Split 1.2.10 PWM-TX Transmit Bit Duration Tolerance(TOLPWM) test to TOLPWM [MAX] 

and TOLPWM [MIN] tests.  

– Split 1.2.10 TOLPWM-G1 test to TOLPWM-G1 [MAX] and TOLPWM-G1 [MIN] tests. 

– Added “TrigThresholdMode” and “Trigger Level” configuration options. These options are 

used to specify the trigger threshold mode and trigger level.  

– Added “Trigger Location” configuration option to set the starting location of the trigger.  

– Added “SYNC Pattern” configuration option under HS Burst Data mode for additional M-

PHY SYNC Pattern searching. 

– Added “Logger” configuration option for DJ and STDJ tests under HS-Burst Mode. This 

option is used to enable/disable the feature to save all waveforms and results for the test. 
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– Added “Transition Density Dependent” configuration option for TEYE and VDIF_AC tests 

under HS Burst mode. This option is used to enable/disable the transition dependent 

density feature.  

– Added “Sampling Rate” configuration option. This option is used to allow Sampling Rate 

selection.  

– Added “Save Waveforms” configuration option for Slew Rate test. This option is used to 

enable/disable the feature to save all waveforms for the test. 

– Added “RSE_TX” configuration option for Vcm test.  

– Added “RJ Bandwidth” configuration option for 1.1.6 TEYE_G3 under BER EYE Opening 

Test Settings. This option is used to allow RJ Bandwidth selection.  

– Added “RJ Method” configuration option.  

Modifications 

– Update MPHY app to apply 1.1.1 HS-TX Unit Interval and Frequency Offset test as 

prerequisite test for any other tests that reference the UIHS measured from this test.  

– Update Slew Rate test algorithm to process rising edges only instead of all edges.  

– Change default value of “Acquisition length” under Jitter Test Setting to 250000 UI.  

– Update tests labels for all tests under HS-Burst Mode and HS-Continuous Mode.  

– Update Slew Rate tests for Gear 2 and Gear 3 as Informative test.  

– Update 1.1.8 Rise and Fall times test under HS-Continuous Mode as Informative test. 

– Update 1.1.17 DJ and 1.1.8 STDJ tests under HS-Burst Mode as Informative test. 

– Update all Jitter tests to use “JTF” options instead of “OJTF” options. 

– Applied TIE filter for 1.1.17 DJ and 1.1.8 STDJ tests under HS-Burst Mode.  

– Update MPHY app to support SYNC pattern searching according to MPHY specification.  

– Reorganize the configuration setting for better usability and identification of HS-Burst 

Mode and HS-Continuous Mode related tests.  

– Update 1.1.1 Unit Interval and Frequency Offset test to compliance with MIPI MPHY CTS 

v3.0r12.  

– Update MPHY app to save waveforms separately for HS-Burst, HS-Continuous, PWM 

Modes. 
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– Update 1.1.5 VDIF_DC(HS) and 1.2.5 VDIF_DC(PWM) tests’ algorithm to support signal 

with long DIF-N.  

– Update 1.2.1 TPWM and 1.2.2 kPWM tests to compliance with MPHY MIPI MPHY CTS 

v3.0r12.  

– Change default value of “Pattern repetition” configuration option to “Periodic”.  

– This option is applicable for all TJ, DJ tests in HS-Continuous Mode.  

– Turn on interpolation for Slew Rate tests. 

– Update 1.1.13 Intra-Lane Output Skew test algorithm to remove the need of using 

“SkewedHalfUI” saved waveform. 

– Update the clock recovery method for 1.1.18 STTJ test under HS-Continuous Mode.  

– Update 1.1.4 Vcm (HS) and  1.2.4 Vcm (PWM) tests’ algorithm to cater for RSE_TX 

tolerance in Vcm measurement.  

– Update all tests that do not have explicit specified measurement threshold method in CTS 

to use the “Hysteresis” measurement threshold method.  

– Disable the “HS Data Eye Filter” to include SYNC region for 1.1.6 TEYE and 1.1.7 VDIF_AC 

tests under HS-Burst Mode.  

– Move “Number of Slew Rate State” configuration option to Setup Page. 

– Masked off Slew Rate tests when “1” is selected for “Number of Slew Rate State” 

configuration option.  

– Supports for Infiniium Oscilloscope Software version 5.00. 

Bug Fixes 

– Fixed issue in Vcm tests by reporting mean value of Vcm measured as final test result.  

– Fixed issue in Slew Rate test where the test cannot be cancelled by user.  

– Fixed connection diagram issue. 

– Fixed bug in PSDCM test where it should be masked off for differential connection type.  

– Fixed scaling issue.  

– Fixed TEYE and VDIF_AC test issue where no enough data for histogram measurement on 

Eye diagram generated. 
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Known issues 

– In loading projects created in MIPI MPHY version 01.11, users cannot append the existing 

results. 
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Agilent U7249A Software Version 01.10 

Released Date: 25 November 2013 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 3.11 (9000 Series, 90000 Series) 

File Name: SetupInfMIPI_M-PHY01100000.exe 

New Features 

– New tests added under LS:PWM Signal Type to support all Test Group configuration 

options(LA_RT, SA_RT, LA_NT, SA_NT):  

o LA_RT Test Group: 

▪ Test ID: 0406 - 1.2.1 TPWM-TX_LA_RT_TX 

▪ Test ID: 0408 - 1.2.2 kPWM-TX_LA_RT_TX 

▪ Test ID: 0403 - 1.2.4 VCM_LA_RT_TX 

▪ Test ID: 0400 - 1.2.5 VDIF_DC_LA_RT_TX 

▪ Test ID: 0401 - 1.2.6 TEYE_LA_RT_TX 

▪ Test ID: 0402 - 1.2.7 VDIF_AC_LA_RT_TX 

▪ Test ID: 0404 - 1.2.8 TR_TF_PWM_LA_RT_TX 

▪ Test ID: 0417 - 1.2.10 TOLPWM-TX_LA_RT_TX  

▪ Test ID: 0407 - 1.2.10 TOLPWM-G1-TX_LA_RT_TX  

▪ Test ID: 0409 - 1.2.11 TPWM-MINOR-G0-TX_LA_RT_TX 

o For SA_RT Test Group: 

▪ Test ID: 0306 - 1.2.1 TPWM-TX_SA_RT_TX   

▪ Test ID: 0308 - 1.2.2 kPWM-TX_SA_RT_TX  

▪ Test ID: 0303 - 1.2.4 VCM_SA_RT_TX   

▪ Test ID: 0300 - 1.2.5 VDIF_DC_SA_RT_TX  

▪ Test ID: 0301 - 1.2.6 TEYE_SA_RT_TX 

▪ Test ID: 0302 - 1.2.7 VDIF_AC_SA_RT_TX 

▪ Test ID: 0304 - 1.2.8 TR_TF_PWM_SA_RT_TX  
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▪ Test ID: 0307 - 1.2.10 TOLPWM-G1-TX_SA_RT_TX   

▪ Test ID: 0309 - 1.2.11 TPWM-MINOR-G0-TX_SA_RT_TX 

o For LA_NT Test Group: 

▪ Test ID: 0206 - 1.2.1 TPWM-TX_LA_NT_TX  

▪ Test ID: 0208 - 1.2.2 kPWM-TX_LA_NT_TX  

▪ Test ID: 0203 - 1.2.4 VCM_LA_NT_TX  

▪ Test ID: 0200 - 1.2.5 VDIF_DC_LA_NT_TX  

▪ Test ID: 0201 - 1.2.6 TEYE_LA_NT_TX 

▪ Test ID: 0202 - 1.2.7 VDIF_AC_LA_NT_TX 

▪ Test ID: 0204 - 1.2.8 TR_TF_PWM_LA_NT_TX  

▪ Test ID: 0207 - 1.2.10 TOLPWM-G1-TX_LA_NT_TX  

▪ Test ID: 0209 - 1.2.11 TPWM-MINOR-G0-TX_LA_NT_TX 

o For SA_NT Test Group: 

▪ Test ID: 0106 - 1.2.1 TPWM-TX_SA_NT_TX  

▪ Test ID: 0108 - 1.2.2 kPWM-TX_SA_NT_TX  

▪ Test ID: 0103 - 1.2.4 VCM_SA_NT_TX  

▪ Test ID: 0100 - 1.2.5 VDIF_DC_SA_NT_TX  

▪ Test ID: 0101 - 1.2.6 TEYE_SA_NT_TX 

▪ Test ID: 0102 - 1.2.7 VDIF_AC_SA_NT_TX 

▪ Test ID: 0104 - 1.2.8 TR_TF_PWM_SA_NT_TX  

▪ Test ID: 0107 - 1.2.10 TOLPWM-G1-TX_SA_NT_TX  

▪ Test ID: 0109 - 1.2.11 TPWM-MINOR-G0-TX_SA_NT_TX 

– Added “MaxNumOfAcq” and “Acquisition length [UI]” configuration option for TJ and DJ 

jitter measurements under HS Continuous Data mode.  

– Added “IntraSkewEdgeHysteresis” configuration option.  This option is used to set the 

measurement thresholds when performing the Intra-Lane Output Skew test. 
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– Added “HS Data Eye Filter” configuration option where user can enable/disable HS Data 

Eye filtering when performing the HS Burst data tests 

– Added “PWM Data Eye Filter” configuration option where user can enable/disable PWM 

Data Eye filtering when performing the PWM tests. 

– Support HS Continuous Data mode testing. 

– Support “Switch Matrix” feature. 

Modifications 

– Removed the “Offline Mode” feature from the setup tab. 

– Renamed the Signal Type label from “High Speed” to “HS-Burst” and “PWM” to 

“LS:PWM”. In addition, the “HS-Continuous” mode is added to the Signal Type options. 

– Removed test ID:405 from the application as this test is not found in the CTS for PWM test 

group. 

– Update all tests as per MPHY MIPI MPHY CTS v1.00. 

– Updated the HS IntraSkew test algorithm to perform edge-to-edge measurement instead 

of using eye diagram method. 

– Changed the default value of the “TestPatternLength” from “3584” to “1320”.   

– Removed the “GEAR and RATE” option (with remote name of “HSDataRate”) in the 

Configure Tab of the application. This option is replaced by a new configurable option in 

the Setup Tab of the application, namely “HS Data Rate” (with remote name of 

“DUTDataRate”). This option is applicable for all “High Speed” Signal Type option.  For 

the “Low Speed” Signal Type option, the related configuration is “PWM Gear” (with remote 

name of “DUTPWMGear”). 

– Due to a data model change in migration to a new framework platform, the entire legacy 

saved project will be loaded as READ-ONLY for viewing purposes. User will not be able to 

append new test results to the legacy saved projects. 

– The “Hysteresis method” measurement threshold is used when performing all the test 

measurements (that does NOT have explicit specified measurement threshold method in 

the CTS specifications).  User can use the “Hysteresis Range” and “Hysteresis Level” 

configuration option to set custom measurement threshold settings.  

– Updated all HS CDR related tests to use a measured data rate value. 
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– All HS Continuous Data tests has been updated to use maximum sample rate and 

interpolation is enabled. 

– Updated connection diagram for all HS tests. 

– Added additional HS Data Rate value options that are referenced from UFS specifications 

in the Setup tab. 

Bug Fixes 

– Resolved the issue where some of user configuration options are not loaded correctly 

when using saved project file. 

– Corrected the typo label of “DIP-P” to “DIF-P” for test reporting in common mode test. 
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Agilent U7249A Software Version 01.00 

Released Date: 16 September 2011 

Requirements category (e.g., operating system): Microsoft Windows XP 

Requirements category (e.g., instrument software version): 3.11 (9000 Series, 90000 Series) 

File Name: SetupInfMIPI_M-PHY01000000.exe 

Initial Release 

Miscellaneous Notes 

– Initial release will consist of 12 HS tests supporting Gear 1, 2 and 3 based on MIPI MPHY 

CTS v0.65. 
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